Contents

1 About this Release .................................................. 1-1

2 Modifications to PDMS Applications ..................... 2-1
   2.1 Isodraft Application Enhancements ................................................... 2-1
       2.1.1 Tolerances and Bore Options ................................................... 2-1
       2.1.2 New Message Layout ............................................................. 2-1
       2.1.3 Critical Overall Dimensioning ............................................... 2-2
       2.1.4 Totalled Repeatable Partnumbers ....................................... 2-3
       2.1.5 DTEXT IGNORE Option ....................................................... 2-3
       2.1.6 Options Files Comments .................................................... 2-3
   2.2 Design Spooling Application Enhancements .................. 2-3
       2.2.1 Modelled Weld Length Option ................................................ 2-3
       2.2.2 User Interface Improvements ................................................. 2-4
       2.2.3 Setting of Spool Prefix Per Pipe ......................................... 2-4
       2.2.4 Detail Plotfile Name .......................................................... 2-4
   2.3 Enhancements to DRAFT Applications .............................. 2-4
       2.3.1 Clash Plotting in DRAFT ...................................................... 2-4
       2.3.2 Changes to VIEW forms .......................................................... 2-6
       2.3.3 Changes to Labelling Forms ................................................... 2-7
       2.3.4 Miscellaneous Features ........................................................ 2-7

3 Changes to PDMS Core Code By Module ............ 3-1
   3.1 DESIGN & PARAGON .............................................................. 3-1
   3.2 DATAL...................................................................................... 3-1

4 General Product Information................................. 4-1
   4.1 Operating System Revision ....................................................... 4-1
   4.2 Product Set ........................................................................... 4-1
       4.2.1 Core Software Modules ........................................................... 4-1
       4.2.2 Associated Data Files ............................................................. 4-2
       4.2.3 Applicationware ................................................................. 4-2
Contents

4.2.4 Utilities ......................................................................................................... 4-3
4.2.5 Catalogues .................................................................................................... 4-3
4.2.6 Interfaces ...................................................................................................... 4-3
4.2.7 New User Documentation Including On-Line Help .................................. 4-3

5 Product User Reports ....................................................................................... 5-1

5.1 Changes Common to All Modules ................................................................. 5-2
5.2 Changes to DATAL ............................................................................................ 5-3
5.3 Changes to DESIGN .......................................................................................... 5-4
5.4 Changes to DRAFT ............................................................................................ 5-5
5.5 Changes to EXPORT ........................................................................................ 5-6
5.6 Changes to ISODRAFT and ISODRAW ........................................................... 5-7
5.7 Changes to MONITOR ..................................................................................... 5-9
1 About this Release

This bulletin covers the release of PDMS 10.4.2, and is one of our regular quarterly maintenance releases. The document covers all new or changed features since the release of PDMS 10.4.1 which include the following:

- DRAFT clash plotting;
- ISODRAFT label layout improvements;
- DESIGN spooling improvements;

as well as a number of other minor features and the usual PUR modification log.
2 Modifications to PDMS Applications

2.1 ISODRAFT Application Enhancements

2.1.1 Tolerances and Bore Options

Tolerance settings for data consistency checks in DESIGN should be matched by tolerance settings in ISODRAFT. These have been available for some time, but were not included in the ISODRAFT application. The ISODRAFT Dimensioning options form has new text fields to set offset and angle tolerances. An option for bores to be Nominal or Actual has also been added, and is now included in the options file as created by the application. The command used is:

```
PRECision BOREs NOMinal/ACTual
```

2.1.2 New Message Layout

ISODRAFT has a new arrowed message layout algorithm, providing a much neater layout than was previously possible. A sophisticated whitespace search operation determines the best position for a message by searching radially away from the arrow head. An optional reiteration operation can then uncross leader lines if necessary.

Two options control message layout in difficult cases. The first option determines the accuracy level of the radial search, based on the number of radial directions searched away from the arrowhead, the number of additional directions for kinked lines, and the length of increments of leader lines.

<table>
<thead>
<tr>
<th>Level</th>
<th>Radial directions searched away from arrowhead</th>
<th>Additional directions for kinked lines</th>
<th>Length increments of leader line</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>18 directions @ 20 degrees</td>
<td>2 directions @ 80 degrees</td>
<td>4mm</td>
</tr>
<tr>
<td>2</td>
<td>36 directions @ 10 degrees</td>
<td>4 directions @ 40, 80 degrees</td>
<td>2mm</td>
</tr>
<tr>
<td>3</td>
<td>72 directions @ 5 degrees</td>
<td>8 directions @ 20, 40, 80 degrees</td>
<td>1mm</td>
</tr>
</tbody>
</table>

Once all messages have been positioned, the second operation repositions any messages with crossing leader lines, and all messages with leader lines passing through the text block. The second option sets a maximum number of iterations, repeating the process until one of the following conditions is satisfied.

- No leader lines cross and no messages need to be moved.
New and Modified PDMS Applications

- The number of leader lines crossing and messages moving is the same as the previous iteration.
- The maximum number of iterations set by the option is reached.

Most usage should be at accuracy level 1. Higher accuracy levels are achieved at the expense of performance. Increasing the number of iterations is not as expensive as higher accuracy levels, as often an equilibrium is reached before the maximum number of iterations. Thus it is recommended that the effect of increasing iterations be examined before resorting to increasing accuracy level.

The ISODRAFT Annotation options form has a new option to set the Message whitespace search accuracy to one of three levels, namely Normal, High or Extreme. A new text field allows the maximum iterations to uncross lines to be set to a whole number.

The new commands are:

- `MESSAGEACCuracy RADial <val>` where `<val>` is 1, 2, or 3
- `MESSAGEACCurity ITERations <val>` where `<val>` is a number such as 9

Example:

```
MessageAccuracy RADIAL 1
MessageAccuracy ITERATIONS 9
```

2.1.3 Critical Overall Dimensioning

ISODRAFT has a new option to dimension to critical components, yet omit dimensions of a lesser importance. This allows for when exact lengths of certain components are not known at the time of design, and some responsibility is delegated to the fabricator to purchase and site-run suitable fittings.

The effect of the new option is to dimension to a single point on each connected assembly of components. The intention is to avoid dimensions that are fixed by fitting lengths, although these are sometimes included when necessary to fulfill one of the rules below. Thus an assembly of components will be dimensioned to a single point, according to the first rule satisfied from the following list.

- Branch connection, such as tee or olet, but excluding tappings on PCOMs and flanges
- Change of direction, such as elbow or bend
- Face of flange or flanged component
- Centreline of instrument
- Centreline of valve
- Origin of first component in assembly

Single components in tube will be dimensioned to their origin, e.g. valves to their centreline.

On the ISODRAFT Dimensioning options form, the Overall Dimensioning has been extended to include an alternative of Critical Dimensions. These may be shown either with or without component dimensions.

The new commands are:

```
DIMEnsions OVERall CRITical
```
2.1.4 Totalled Repeatable Partnumbers

The use of database partnumbers allocates an individual partnumber to each component and length of tube. Using these partnumbers in ISODRAFT provides an individual entry in the material list for each item, as required by many fabricators, but leads to long material lists. ISODRAFT now allows totalling of like items in the material list when database partnumbers are used. Multiple partnumbers will be output, separated by spaces, in a single entry in the material list, wrapping round if the column width is exceeded. The quantity column will show the total for like items. Part number tags will still be individual. The new commands are:

```
PARTNUMBERS FROMDB SEParate
PARTNUMBERS FROMDB TOTotalled
```

2.1.5 DTEXT IGNORE Option

Component descriptions normally include both detail and material text, but could exclude material text if required. A new option allows the detail text to be excluded instead. On the ISODRAFT Material options form, the Descriptions option has been extended to allow the material text only to be output. The new command is:

```
DTEXT IGNORE
```

2.1.6 Options Files Comments

The ISODRAFT application has a new facility to include comments in an options file, for use in describing its purpose, author, etc. The comments can be set and displayed in a text pane on the Administration options form. They can also be displayed (but not modified) from the Standard Isometric and System Isometric forms. The options are output at the top of options files using the Appwaretext command (a simple mechanism to allow the application writer to store and extract data from options files).

2.2 DESIGN Spooling Application Enhancements

2.2.1 Modelled Weld Length Option

The DESIGN Spooling application can create and number welds automatically, and requires welds to be available in the appropriate pipe specifications, with certain selectors. One of these was the EDGE selector, used as part of the mechanism to allow welds to be modelled with a length. Use of the EDGE selector has been made optional. This simplifies the specification requirements for welds, but limits welds to being zero length. This option is controlled by a single toggle on the Spooling Administration form. Note that if you have defined EDGE selectors in your pipe specification, you must switch this option on.
New and Modified PDMS Applications

2.2.2 User Interface Improvements

The user interface has been slightly modified to be more consistent with other DESIGN applications. The non-standard graphical view is no longer used, and all graphical interaction takes place on normal graphical view forms. Some of the specific Modify options have been removed, as their functionality has been incorporated into the General Modify menu operations (for example, Modify>Network>Node has been removed and is catered for within the General Modify>Node). Some functions have been moved from the Modify menu to the Utilities menu. The Rebuild Spool View menu option will now generate a view if the network zone is the current element.

2.2.3 Setting of Spool Prefix Per Pipe

A new Spool Prefix form allows a spool prefix to be defined for a Pipe or a Drawing, in the SPLP attribute. SPLP will be set for the current element if it is a Pipe or Drawing. If it is a branch or a piping component, then if the branch's DRRF attribute (Drawing reference) is set, the Drawing SPLP will be set, otherwise the Pipe SPLP will be set.

The Numbering form has an option for spool numbers to use this attribute instead of specifying text for the prefix. Spool identities defined in the Spooling application will then consist of the value of the SPLP attribute together with the spool number. The SPLP attribute will be taken from Pipe or Drawing, depending on which level is being numbered. If a single branch is being numbered, the Pipe's SPLP will be used.

2.2.4 Detail Plotfile Name

A new attribute DPFN (Detail Plotfile Name) has been provided on all branch members, which will be used to associate detail sketches with piping components, for inclusion on an isometric. It has been included as preparation for future developments.

2.3 Enhancements to DRAFT Applications

2.3.1 Clash Plotting in DRAFT

The clash plotting utility is available in all applications from the utilities menu:

Utilities>Clash Plotting...

which shows the "Clash Plotting" form. This form enables the user to take a clash output file from DESCLASH and generate a series of clash plots for each clash specified in the file. An appropriate plot template sheet and backing sheets now exist in the standard data files.

The DESCLASH "Template Macro" file is generated in DESCLASH, as described in the DESIGN Reference Manual. The REPORT MACRO TEMPLATE FILE required by DRAFT, to generate clash plots, is found in the defaults directory:

DRA-GEN-CLASHTEMP
which is used by DRAFT to determine the relevant clash data for each clash in the report. An example of a series of commands to create a Clasher macro for DRAFT follows:

```
Enter DESCLASH:
  DESIGN
  DESCLASH
Generate clash data:
  OBST /STEEL_AREA_A
  CHECKADD /PIPES_AREA_A
Generate clash macro for input into DRAFT:
  REPORT MACRO /%PDMSDFLTS%/DRA-GEN-CLASHTEMP
  ALPHA FILE /DRAFT.MAC
  OUTPUT
  ALPHA FILE END
  REPORT MACRO OFF
Leave DESCLASH:
  EXIT
  FINISH
```

The clash plotting utility uses a template DRAFT SHEET that has been generated by the user. CADCentre supplies an example clash plot sheet /10.4/TMPLT/CLASHA/S1 that exists in the /10.4/DRG-TEMPLATES DEPT. The sheet is automatically created when the DRAFT macro:

```
DRA/DATA/DRAFTTMP.DAT
```

is loaded into the relevant DRAFT database. The supplied sheet consists of two views and an example title block and backing sheet. It is recommended that the sheet drawing is copied into the user area and renamed before it is used to generate any clashes. This allows the user to add any additional annotation that will appear on all clash plots.

The clash data that will appear in the title block of the sheet is stored on the backing sheet as hidden text primitives. The text primitives have BTEX set to KEYWORDS that the clash plotting program recognises. These keywords are substituted with the relevant clash data for each plot generated.

Note: each TEXP on the backing sheet that contains a keyword should have its visibility set to FALSE. The visibility at plot time is toggled by the plot utility.

The Clash Sheet is referenced on the main form. Any of the following keywords (variables) may be present in TEXP BTEX on the clash sheet notes:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!CLASHEE</td>
<td>Clash template sheet name</td>
</tr>
<tr>
<td>!CLAID</td>
<td>Clash run ID</td>
</tr>
<tr>
<td>!CLADATE</td>
<td>Date of clash</td>
</tr>
<tr>
<td>!CLAUSER</td>
<td>User name of person who performed the clash</td>
</tr>
<tr>
<td>!CLAOPF</td>
<td>Output format (F:File, P:Printer, FP:File&amp;Printer)</td>
</tr>
<tr>
<td>!CLADIR</td>
<td>Plot directory</td>
</tr>
<tr>
<td>!CLASUF</td>
<td>Plot suffix</td>
</tr>
<tr>
<td>!CLA1</td>
<td>1st clashing item</td>
</tr>
<tr>
<td>!CLA2</td>
<td>2nd clashing item</td>
</tr>
<tr>
<td>!CLAPOS</td>
<td>Clash position &quot;Eval Nval Uval&quot;</td>
</tr>
</tbody>
</table>
New and Modified PDMS Applications

!CLANUM Clash number
!CLATEXT Clash description "type,cla1,cla2"
!CLAOWN1 Owner of !!CDCLA1
!CLAOWN2 Owner of !!CDCLA2
!CLAPOSE Clash position easting
!CLAPOSN Clash position northing
!CLAPOSU Clash position upping
!CLATYPE Clash type: HH,HS,HI,SS,SH,SI,II,IH,IS,NP
!CLACATE Clash category: CLA,TOU,CLE

The Clash plotting form has the following gadgets:

"Clash Report" Clash report macro from DESCLASH
"Clash Sheet" DRAFT template clash plot sheet, described above
"Clash Run ID" SINGLE string (NO SPACES ALLOWED), used in the title block of the clash plot and also used in the naming of plot files, if output is to File.
"User ID" User ID for clash run (appears in title block)
"Date" Date of clash run
"Output settings" Various options affecting the output
"Create Macro" This button creates a batch macro that the user defines in the adjacent text field. The batch macro can be run by the user in his/her preferred batch service, to generate the clash plots as defined on the clash plot form.

Note: IF the user has previously created a batch macro, s/he can type the macro name into this gadget and the macro settings will be restored onto the form.

ALTERNATIVELY, the user can "Run Live..." the clash plotting function direct from the form. This will generate the plots in the current users session.

The user can also "Preview..." the clash plots from a "Clash Preview" form, which allows the user to view any selected clash as defined in the clash report file. The user can move to the selected clash reference number via the gadgets on the right of the form, or directly type in the clash number s/he desires directly into the numeric field. Simply hitting the "Preview" button results in a view of the clash plot. The plot is generated live and displayed in the area view on the preview form.

2.3.2 Changes to VIEW forms

The "View>Offset" form has been resurrected in response to PUR 21638 to re-enable the setting of the ONPO attribute for views, albeit with the following restrictions:
New and Modified PDMS Applications

- ONPO is only valid for user defined views
- ONPO is forced to (0,0) if the user wishes to modify a view as a standard scale view. Offset does not make sense with the standard scale form (it makes the view limits confusing to read.)
- the user is warned that the ONPO is not maintained with the standard scale form and is reset to (0,0) with the consent of the user.

2.3.3 Changes to Labelling Forms

There is a new label visibility form to allow the user to show/hide any GLAB/SLAB. This form replaces the "Modify>Show/Hide Label" and "Modify>Show All Labels" options on the label application menu. The new form has additional functionality over and above that provided at PDMS 10.4.1.

2.3.4 Miscellaneous Features

The "Re-open" gadget has been changed, on all relevant top bar menus, to a button which enables the user to "DROP" the current working sheet from the re-open list. This was to partially satisfy PUR 22078.
3 Changes to PDMS Core Code By Module

3.1 DESIGN & PARAGON

Orientations may now be input and queried as three angles by referring to the pseudo-attribute ORIAngle. This was introduced primarily to improve the accuracy of loading data from DATAL files and to reduce the burden on applications which require orientation in angle format. See section 5.2 below.

The minimum length for implied tube is no longer hard-wired to 1mm but is now taken from the value set by the TOLERANCE OFFSET command. This may be queried using Q TOL OFFS and defaults to 1mm to remain compatible with older versions.

3.2 DATAL

For improved accuracy, orientations are now output as angles with the ORIAngle attribute, although the old style is still output as a comment. For example:

```
NEW VALV
  AT W17246.099 N12125.000 U4130.000 ORIA 180.000 -75.000 90.000
$( ORI Y IS E AND Z IS N 15.000 D $)
  SPRE SPCO /A3B/VGG10 LSTU SPCO /RF300/10TU BUIL TRUE SHOP TRUE
  ORIF TRUE POSF TRUE ISPE SPEC /INSPEC
END
```
4 General Product Information

This section is intended to provide you with a summary of PDMS components and other auxiliary information associated with the release of PDMS 10.4.2.

4.1 Operating System Revision

PDMS 10.4.2 has been built on the following operating systems at the specified revisions:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Revision</th>
<th>Manufacturer</th>
</tr>
</thead>
<tbody>
<tr>
<td>IRIX 5.2</td>
<td></td>
<td>Silicon Graphics</td>
</tr>
<tr>
<td>HP-UX A.09.01</td>
<td></td>
<td>Hewlett-Packard</td>
</tr>
<tr>
<td>OSF 1v2</td>
<td></td>
<td>DEC Alpha</td>
</tr>
</tbody>
</table>

For information about supported hardware and operating system revisions, please consult the PDMS 10.4.2 Installation Guide, or contact CADCentre.

4.2 Product Set

4.2.1 Core Software Modules

The following modules are being supplied at this release:

<table>
<thead>
<tr>
<th>Module</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ADMIN</td>
<td>DATAL</td>
</tr>
<tr>
<td>ENTRY</td>
<td>EXPORT</td>
</tr>
<tr>
<td>MONITOR</td>
<td>PARAGON</td>
</tr>
<tr>
<td>REPORTER</td>
<td>SAINT</td>
</tr>
<tr>
<td></td>
<td>SPECON</td>
</tr>
<tr>
<td></td>
<td>STRESSP</td>
</tr>
<tr>
<td>DESIGN</td>
<td>DICE</td>
</tr>
<tr>
<td>ISODRAFT</td>
<td>ISODRAW</td>
</tr>
<tr>
<td>PROPCON</td>
<td>RECONFIGURER</td>
</tr>
</tbody>
</table>

DESIGN and PARAGON use the same executable program file. DICE comes as two separate programs: DICE 'inside PDMS' and DICE 'outside PDMS'; the latter is also known as 'standalone DICE'. There are three separate ENTRY programs, for ordinary, batch and privileged mode.

The following modules have been totally withdrawn from this release:

<table>
<thead>
<tr>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRAWCON</td>
</tr>
<tr>
<td>GROUT</td>
</tr>
<tr>
<td>SCHEMA</td>
</tr>
</tbody>
</table>

Neither is SCHEMA supported any longer as a stand-alone utility.
General Product Information

4.2.2 Associated Data Files

The following files are associated with the core modules:

- message.dat
- attlib.dat
- modmac.mac
- delmac.mac
- makemac.mac
- makmac.mac

Font Files
Virgin Databases
General setup files (.cshrc.pdms, .Xdefaults)
Sitefile Templates
On-line Help Files

4.2.3 Applicationware

The following applications are supplied at this release:

**DESIGN**
- General User
- Equipment
- Accessways Stairs and Ladders
- Piping
- Cable Trays
- HVAC
- Spooling

**DRAFT**
- General User
- Dimensioning
- Labels
- 2D Drafting
- AutoDraft
- Administrator

**ISODRAFT**
- General User

**PARAGON**
- Pipework
- Steelwork
- Specification Generator
4.2.4 Utilities

These are the utilities which are supplied at this release:

- DARS (FORTRAN interface)
- DARS (C interface)
- SPECGEN
- MAKE and MAKES
- PLOT
- FATC (sitefile server)
- SFCONF (sitefile configurer)

4.2.5 Catalogues

The ISO-CAT piping and nozzle catalogue is being supplied as at earlier releases, but only to new customers. The following application-specific catalogues are also supplied:

- Steelwork Catalogue
- HVAC Catalogue
- Cable Tray Catalogue
- Hangers & Supports Catalogue

4.2.6 Interfaces

The list of supplied interfaces includes:

- AutoDRAFT-12
- SAINT-GT

AutoDRAFT-11 (i.e. the interface to AutoCAD, release 11) is no longer being supplied. Note that the version of AutoDRAFT supplied with this release is identical to that supplied at PDMS 10.4.1 and so it isbannered AutoDRAFT 10.4.1-R12.

4.2.7 New User Documentation Including On-Line Help

The following paper documentation is available with PDMS 10.4.2:

- AutoDRAFT User Guide
- CADCentre Software Customisation Guide
- DESIGN Reference Manual
- DRAFT User Guide
- ISODRAFT Reference Manual
- PDMS 10.4.2 Installation Guide
- PDMS 10.4.2 User Bulletin (this document)
- PDMS Basic Features Guide
General Product Information

In addition, the DESIGN Spooling Application and the REPORT Facility are provided with on-line help documents.
5 Product User Reports

This section describes all PURs which have been resolved since the release of PDMS 10.4.1. They are listed by module on separate pages so that they may easily be copied or included in your manuals if required. Responses to PURs which were reported in bulletins for earlier releases are not usually included, as it is assumed that you will already have these bulletins. Any PUR discovered to have been resolved at an earlier release but which has not yet been reported is included. Users responsible for raising specific PURs which result in changes to PDMS, should already have been notified individually of our response.
5.1 Changes Common to All Modules

20592 When setting a UDA back to its default value, if the element is locked no message was generated in earlier releases. This has now been rectified.
5.2 Changes to DATAL

22214 Attribute DDNM is now output as a treename rather than a reference when pointing to an unnamed element.
5.3 Changes to DESIGN

The `CHOOSE` command has been enhanced to allow choosing of LSTUBE, HSTUBE, LSROD, HSROD, TUBE and ROD attributes.

Problems with TWODP and grids now resolved.

Obstruction setting is now handled correctly for implied boxes, ducting, etc.

Handling of inter-db macros has been improved and corrected.

Correction of tolerance handling now prevents part numbering problems.

Marking aids on SJOI & FITT are now positioned correctly.

Redrawing of steelwork components which have been moved is now correct.

"White out" of SITEs and ZONEs after clicking the "NO" button after attempting to delete the current element no longer occurs. Top level elements can now be enhanced.

Datacon check of nozzle from spec no longer causes Dabacon crash.

Design parameters have now been provided on EQUIs and SUBEs.

Attempting to use a cutback value with the `RECONNECT` command for beams running North to South no longer results in a Structural geometry error message.

The `CHOOSE` command has been enhanced to allow for a range in pressure as well as angle for elbows.
5.4 Changes to DRAFT

18036  Use of RULE SETs can improve the appearance of dimensions on skewed pipe, by
18808  using a constructed dimension point. The dimension is then between one element and
a dimension point defined by a RULE SET for POS which uses the Easting/Northing
(say) of that element and the Upping of another.

21638  The View Offset form has been reinstated.

22078  It is now possible to create and delete a SHEET element in the same working session.

22174  Missing 0 in Inch Output corrected

22200  Spurious arcs are now suppressed.

22381

22210  Sections are now drawn correctly when cutting planes are not orthogonal.

22341  The size of the CRIT attribute has been increased to 250 elements.

22344  "Disk full" messages now include a warning that Picture Files and the Spatial Map will
not be updated.
Product User Reports

### 5.5 Changes to EXPORT

- **20892** Errors in modelling implied boxes and tube for cable trays corrected. They are now treated in the same way as in DESIGN.
- **21936**
- **22700**
- **22087** SUBEquipment with holes was not exported correctly. This has been corrected.
- **22277** The presence of LOAP elements no longer cause a Dabacon crash.
5.6 Changes to ISODRAFT and ISODRAW

Incorrect, misplaced, missing or spurious dimensions now rectified.

Incorrect, misplaced, missing or spurious part numbers now rectified.

Incorrect, misplaced, missing or spurious weld numbers now rectified.

Incorrect, misplaced, missing or spurious piping components now rectified.

Incorrect pipe orientation and detailing corrected.

Blank spool isometric no longer corrupted by flow arrows.

Missing bolting information now appears.

Spurious text attached to 'fall' note no longer appears.

Missing comment at flange restored.

Spool ID on wrong sheet with different split factors has now been corrected.
Product User Reports

21727  Spec breaks in undesirable places now suppressed.
21764  Improved handling of itemcodes after error.
21818  Spool ID's sometimes missing from material list now restored.
21842  Handling of user-defined SKEYs and symbols has been improved.
21855  Incorrect material list for multi-bore components rectified.
22008  The 50D bend radius restriction has been removed.
22075  Text positions are now stored internally to greater precision.
22159  Bad bypass join when detailing a closed loop corrected.
22184  Navigation error while searching for bolts part number has been rectified.
22238  Spool tag duplicated at reducer now only appears once.
22239  Preamble to error message corrected.
2240   In pipes where all branches are connected head-to-head the error message ‘not in network’ no longer occurs.
22343  Totalled repeatable part numbers now available.
22392  Missing syntax for the REPORT facility has now been added to ISODRAFT.
22398  The OPTIONS DEFAULT command now clears previous TEXTPOSITION settings.
22655  Standout is no longer flipped if forced.
22674  Incorrect treatment of 180 degree bend has now been rectified.
22698  Orientation note on sheet now corrected.
22701  Spool numbers mismatch between drawing and material list resolved.
22716  Cut lengths in material list now corrected.
22723  Orientation of branch with LJSE as initial member rectified.
22738  Q APPWARETEXT crash no longer occurs.
5.7 Changes to MONITOR

22213 System crash after selecting an MDB which contains more than 100 databases no longer occurs.